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ModelicaML Tutorial

ModelicaML: Technology
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@ Modelica Code Generation
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10 parameter Real minV

14 parameter Real
15 parameter Real

within TwoTanks:

function limitValue

input Real pMin:
input Real pMax;
output Real pLim;
input Real p;

algorithm
/# code gemersted from the Aevivicy "algorithm
/¢ Activity.neme: "algorithm (disgrem) "
if p < plin then
plLim := pMin: // Opaguelction.name:
elseif p > pllax then

(Aagram)

"plim = plin; "

within Designliodels;

model Tank

™ 1 tSensor; //Connector, sensor reading tank le
TuoTanksSystenExample.Designliodels. AetSignal thetuator; //Connector, actuator controlling
TuoTanksSystenExample. Designliode 1s. LiquidFlow oln; //Connector, flov (m3/s] through input
TuoTanksSystenExample. Designiiode 1s. LiquidFlow qOut; //Connector, £low (m3/s) through outpu
flovGain(unit = "m2/s") = 0.05,

nv = 0; //Linits for output valve flow

1 15, Reac

parameter Real

11 parameter Real maxV = 10; //Limits for output valve flow
12 Real histart = 0.0, unit = "w”); //Tamk level
13 parameter Real tank height = 0.6;

tank_wideh = 1;
tank_length = 1.3;

within Designlodels;

model TanksConnectedPI|

TwoTanksSystewExawple . Designlodels. LiguidSource source (Elowlevel = 0.02);
TwoTanksSystenExample. Designiodels. Tank tankiz
TuoTanksSystemExemple.Designiodels. Tank tank2 (tank length = 1)
TwoTanksSystenExample . Designlode ls. PIcont inuousController piContinuousliref

equation
connect (source. gout,
connect (piContinuousl.cIn, tankl.tSensor);
connect (piContinuousl.cout, tanki.thctuator);
connect (tankl.qOut, tank2.qln)?
connect (piContinuousZ.cIn, tank?.tSensor);
connect (piContinuousz.cout, tanksz.thctuator):

tankl.qIn) ;

19 end TanksConnectedPI;
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ModelicaML: Technology

Papyrus UML
ModelicaML Profile (Eclipse Plug-In) Any Modelica Simulation Tool

File Edit Insert Tools Help

Open Save | Print | Select | Zoom | Pan | Grid | Hold | Preferences | Active | Image

Plot by OpenModelica
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Required Installations

*If not installed yet: JavaSE-1.6 from
, required for Eclipse.

Eclipse 3.6 (Helios) Modeling from

*Papyrus MDT Eclipse plug-in (find the update site on
) for modeling with UML

*Acceleo Eclipse plug-in from for
Modelica code generation from ModelicaML models

*ModelicaML Eclipse plug-ins from
for modeling with ModelicaML
(ModelicaML plug-ins that are available for Papyrus MDT)

*OMC from . OpenModelica Compiler used
for simulation.

*Modelica Development Tooling (MDT) Eclipse plug-in (find the update site on
) for viewing the generated
Modelica code if needed

For details see:
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General Description of the
UML-Based Graphical Notation
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ModelicaML Tutorial

ModelicaML: Graphical Notation

20.03.2011

wmaclels
(TwoTanksSystemExample:: Designlodels:: Models Libran
BaseController b e — [ES srecuirements
£ evariables K ModelicaReal TanksConnectedPl id = 001 Max level of liquid in a tank
=} «variables T ModelicaReal = Renif] R . . .
E:m”ab‘e» R e «cusnz)p::zr:» Iexdt BD-EPE ]Le\:!l ofIELrl:d_w;]a tank shall never | & avatiables maxlevel ModelicaReal
i evariables error: ModelicaReal EmeRet] G @/l e_tan HIEET £ evariables tank_height: ModelicaReal
E} evariables outCr: MadelicaReal g0ut ‘CDT::’S;“’ “WT;’:E“’ specifiesType = [Tank] £ evariables level: ModelicaReal
qin qOut qin qout
.| «ExtendsRelations D D D
- typehodification = tensor thctuator  tSensor tactuator
- [ES srequirement:
«Reguirements
amadeh id = 002 Volume of the tank1
TwoTanksSystemExample:: Designlodels] = " . .
{ PIC&;I“imm“séﬂ‘m"o”;’ ) acampaner ot text = The v_olum_e of the tank1 shall be 0.8m3. 2 wvariables tank_volume: Modelicareal
piContinuous1 piContinuous? specifiesObject = [TanksConnectedPl.tank1] E] evatizhles design_value: ModelicaReal
= evariablas x: ModelicaReal
=} evariables powered: ModelicaBoolean
cin cOut cln cOut
' amodelicaStateMachings
R6-1: Requirement violation monitor
¢ «modelicaStateMachines
Tank states
«CONCtionalAlgarithm{Diagrsm): — . o
limit value algorithm ‘ Monitoring signal reception |
‘ Unset violated /entry |
[h=0001] [caution_signal_received]
empty partially filled ‘ Waiting for alarm activation |
i B [h=0.001] -
, [p = phtax] [p=pMin] ‘ Set evaluted /entry |
pLim = pMax: H pLim := pMin; [ > tank_heigk
S s, [AFTER{0.AY and {not alarm_is_activated) ]
[h = tank_height] [notcaution_signal_recdived]
~
| Violated
pLim = p: ‘
|__ ! P Set violated fentry
. .
Mo /’
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ModelicaML: Class Diagram

FMOce]:
{ Pwo FanksSystemExample: Designllodels. Models Librang
BaseController

= ¢varisble: K ModelicaReal

= ¢varisble:x T: ModelicaReal

= ¢varisbles ref ModelicaReal
= ¢varisbles error; ModelicaReal
= gvariables outCtr ModelicaFeal

| «ExtendsRelation:
- typeModification = [K =2, T = 10]

imodels
fTwoTanksSystemExample: Designliodels)
PlcontinuousController

= evariables x: ModelicaReal
= evariabler powered: ModelicaBoalean

(Two-Tanks System Example)
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ModelicaML: Connection Diagram

moclels
{ Two TankaSystemExample: DesignWode!s)
TanksConnectedPl

v

gomponent: gomponent: gromponent:
source tank1 tank?
fqout qln fiout ] r gln qOut
tSensor tactuator tSensar tactuator
FCOMponent: ZCOMmponent:
piContinuousi piContinuous2

4[F| cln cOutl:; [ cn cOut[Flf

(Two-Tanks System Example)
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ModelicaML Tutorial

ModelicaML: State Machine Diagram

20.03.2011

smodelicaStatedachines
player modes

m [ changedhmi.an) and (powered arbatteryLewel =0.0173 ]
‘ off [ changedhmi.offy or{not povvered and batterylewvel = 0.01)] "w"l
= "
| Set discharge rate /do on

Set discharge rate /do

W

[ changethmiplayi]

stop

M

[changefhmi.stop)]

play

(Two-Tanks System Example)
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ModelicaML Tutorial

ModelicaML: Conditional Eq./Alg. Diagram

20.03.2011

-

-

gconditionalEquations{Diagram)s
Calculate battery status

¢otatelependencys
islnState = [unplugged, on)
logicalOperator = and

«StatelDependencys
isinState = [plugged]

7

F
astatepfependenm

S
\I,.: «stateDE}s\gndenm

T
) [ batteryLevel == 0]

L hattery is used (discharging) hatteryLavel == 1 ]
atteryLevel ==

}[ hattery is not used {charging) ]

-

-

L hattery status doesn’t change W
A

(Player Example)

Page 10

EADS



ModelicaML

Hands-on Modeling Tutorial

EADS



ModelicaML Tutorial 20.03.2011

Example: Two Tanks System

*From “source” liquid flows into the “tank1”

*Controller “piContinuous1” controls the level of liquid in “tank1”, based on a
predefined reference value, by opening and closing the tank outflow valve.

*Liquid flows from “tank1” into “tank2”

*Controller “piContinuous2” controls the level of liquid in “tank2”

TanksConnectedP1
Source gln qQOut gln gOut
tank1 tank2
tSensor tActuator tSensor tActuator

—Cm»l# piContinuous I#COU’[ Cl;#lpi[fmntinumls #W

Source: Peter Fritzson. Principles of Object-Oriented Modeling and Simulation with Modelica 2.1. Wiley-IEEE Press, 2004. page 391.
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File  Edit

a0 Qg . - i - Thd -
afg T Tf p = [

Diagram ‘Window Help

- Model Explor 53 [ Project Expl
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o 2R E Q%

B 5 B3 TwoTanksExample
=-E3 Design
@ TanksConnectedPI
3 Library
=-E3 Components
ﬁ LiguidSource

ﬁ Tank
EE Controller Inheritance
B3 Interfaces
B3 simulations
t_ profileapplication (113

B Class Components Tree 23

% — - E&:\:‘Eva%v

<P *model.di 22
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23

L2 Palette

[ @ &

sm: Tank States

= Modes

levelOfLiquid = 0.01

Empkty

levelOfLiquid < 0.01

levelOfLiquid < height

() Reqion

(&0 State

Partially filled
® ShallowHistary

3

3 él Choice

+ () EntryPoint

+ @ FinalState

= Edges 40
% Transition

Overflow

| ¢

<
EE Controller Inheritance CompositeDiagram T.ﬂ sm: Tank States 53

| %

@ Initial

(B]B ¢

= Properties 22 @f ModelicaML Yalidation @ Error Log | & Consale

Q < <model=> <Class> PIcontinuousController

:"v=ﬁ

urL Mame: | PIcontinuousCantraller
=] Q ‘PlcontinuousController’ components ModelicaML
+ Modelica Specific Properties: Restricted Class
O cnit) Prafile
I% cCut (1) dvanced Partial: Oitrue & False
errar

k=2 Replaceable: Oitrue @ false
EE outctr Final: Oitrue @ false
& ref

Encapsulated: Otrue @ false
B T=10 "
E x
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ModelicaML Papyrus MDT GUI Overview

@ Model Browser: Shows model elements

@Properties View: Shows the properties of selected element
©Diagram Editors (different UML-based diagrams)
OPalette (different for each diagram)

@©ModelicaML code generation and validation buttons

@ Component tree: Shows the components hierarchy of the
selected class

Page 14 EL\DS
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ModelicaML Tutorial

Create ModelicaML Project

*Open Eclipse

*Change the Perspective to Papyrus Perspective

Page 16

& Open Perspective

18
. Accelen

! Acceleo

oL

[H'CDO Explarer

%C\-‘S Repasitary Exploring
f’ﬁ«Debug

@ Ecore

%Jllava (default)

E,leava Browsing

EJJava Twpe Hierarchy
=P

=)

S EDDTIT
“I=Plug-in Development
|._[\j Resource

§D Team Svnchronizing

] l Caniel

20.03.2011
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ModelicaML Tutorial

Create ModelicaML Project

& Papyrus - Eclipse
Edit  ‘Window Help

Ale+ShifE+-M

<3 Papyrus Model | & New Papyrus Project

(9 Folder Papyrus Project —
[=<J> Example. N Create a Mew Papyrus Project B
. 2

[ other... Ctrl+M

Praoject name: | madelicaml, example bwaotankssysten |
| Use default location

| Erowse...
Working sets
[] add project ko working sets
Select...
L]
Go to File -> Create ...
@ = Back Mext = ] Finish ] [ Cancel ]

Page 17 E@S



ModelicaML Tutorial 20.03.2011

Create ModelicaML Project

& New Papyrus Project

Initialization information

Select language of the diagram

Diagram Language: & New Papyrus Project

L] _i SysML Initialization information I
Select name and kind of the diagram B

Ciagram Mame:

M NDdEhEﬂML MeswDiagram |

Select a Diagram Kind:
Ll Profile
P t

‘fou can load a template:
l [ IModelicalL kemplate incl, Requirements, Desing and Simulation Packages (madel,uml) :

@ < Back IJ Mext = 1” Einish

[CJremember current selection

@ ek = I Finish IH Cancel ]

Pago 1 EADS
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Papyrus Project Files

& Papyrus - modelicaml.example. twotankssystem/model. di - Eclipse

File Edit Diagram Window Help

: . i - - B e -2 HE B
. . Dlagram flle .. | B Model Explorer EjF'rn:nject Explorer &2 = O |*? model.di =2
(can only be edited using Papyrus MDT) el —ra

\EFI& modelicaml, excample, bwotankssyskem

) ey

|=| maodel. nakakian

4 g model, uml

Model file .-~
(can be edited using any UMLZ2 tool)

page 1 EADS
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Configure Model Explorer

Page 20

£= Papyrus - modelicaml.example. twotankssystem/model. di - Eclipse
File Edit Diagram ‘Window Help

s = | B | 5%

“¥ *model.di 23

= B2 model
EIEI Dresian
E «Madel: Madel
F-E3 simulations
Bt profilespplication {113

& |oad Customizations

fvailable Customizations ed Customizations

| bype Filber bexk ModelicaMLCustomization

----- ﬁ SysMLDef aultExplorerCustomization UMLPapyrusDefaultBrovser Customiz

<

s W

| rs

I ] >

| ry

il ] >

Load referenced Facets -

o [ e |
~— 3 EADS



ModelicaML Tutorial 20.03.2011

Change and Customize the Perspective

& Open Perspective |:.® m

\__ij.ﬂ.ccelen —
I Accelen ? |E
Can
[H'CDO Explorer
C'-.-'S Repaository Explaring
ﬁgebug Select and customize the ModelicaML perspective —
core
&)1ava disable all features that are not used
&JJava Type Hierarchey
H Modelica v - - . o iy P
M8 Modelica Interactive Simulation Sessian ot HET I ERTEET e 6 Lock the Toobars &
M8 rModelica Mon-Interactive Simulation | r':””

Typical ModelicaML customized perspective:

& ModelicaMl. Modeling - modelicaml.example. twotankssystem_v02/model. di - Eclipse Platform |Z||§|E|
File Edit Diagram Search ‘Window Help

B 7| A e e | R o R P - LA
- Madel Explarer 53 rﬁ‘_jProject Explorer = 07 modeldi 2 =0
@ (SRl = <'==={> = A1 5F Palette [
= Ex TwaTanksExample ! TanksConnectedPl ! NOYE)

Page 21 EAQS
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ModelicaML Tutorial 20.03.2011

Create Model Structure

Create Packages and Classes using ModelicaML menus

"

=
%‘_ Model Explare &3 rﬁ_ﬁF‘rnject Expllﬂ =0
=

- Model Explorer &3 [T Project Explurer] = 87D model.di 2
) d <}=‘
AR BES

BAlBdkBes -~

| TanksConne = B2 model

=B Design

@ TanksConnectedPl
=-E3 Library

gln

goutf L b e il BaseController
Execute Quer S [ e e | R S & limityalue

F7 Package(s) h =-E3 Components
ModelicaML: Mew Diagran EE Class Diagramn  — 1| ¥ i e ﬁ Liquidsource

t' Requirements Impott profile from registered profile
#-F3J _valueBinding
B3 Design
#-E3 simulations
#-t profileApplicati

Import package from File

Import package fram registered library
Creakte Query

.4
ModelicalL: Yalidation and Code Generation » I (| I T A ﬁ PlcontinuousController
Mew Child » ﬁ Requrement(s) — f  ff b b i ﬁ Tark
. System Model{s)

Mew Diagram 4 % : i =-B3 Interfaces
3 Delete Delete Interface Definkionis) |, E ActSignal
J validation b ColculgtonModelis) e LiquidFlow

[ Simulation Model(s) T | E Readsional
|| Rename. .. Fac-lana
Modelica Classes r

of Cut |

Page 23 EAD S



1
't;’f}elicaML Tutorial 20.03.2011

Hint: Setting type of components

| By Model Explare 53 [ Project Explo = O 7P model.di 32 =0
:,_ BEAEES
= 5 B2 model
=-E3 Design
ﬁ TanksConnectedPI
=-E3 Library
= ﬁ BaseConkroller

=t o 2

O cQut N
@ limityalue N
Carnponents ~
ﬁ LiquidSource N
ﬁ PIlcontinuousConkraller N
ﬁ Tank \‘\
Inkerfaces ~<
E ActSignal S
fe] LiquidFiow =] Propertie\sfx [f2], MadelicatL validation
E ReadSignal N
=BT Simulations

@ TanksSystemSimulation
t_ profilespplication (11)

é@i
q

i
|

= O = =3 [
£l
| |

=] {{cnnnec}iu Port:>> <Port> cIn : ReadSignal

uraL Mame: | cIn |
ModelicaML

Madifications Type: & <<ronnector>> <Class ReadSignal

= _ (i SulbEE + Modelica Specific Properties: Component

— Prafile
|<}=| 9@~ Final: Orue @)False

&5 Class Components Tree 53

L Advanced
= E 'Base_ontroller’ components Replaceable; Otrue (& false

H e Causality: (O <tnset>  Oinpur (O output
O cout

:¢ O 1 items selecked

pago 24 EADS
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licaML Tutorial

Hint: Setting type of components

& Select Type:

Select the reference wou wank for Type:
~Loaltin: Thiz informationis derived From the return result For this Operation, The bype of t

| modelicareal

Matching ikems:

) <Primitive Types ModelicaReal

20.03.2011

'M@m?m' Q) Error Log | B Console

B <<variable>> <Property> flowLevel : ModelicaReal

LML

Modelica™ML
Modifications
Deeclarakion

<Frim Cond. Expression
Array Subscripts

@Prcﬂn

Mame:

Type:

| FlowLevel

<Primitive Type> ModelicaReal

| = Maodelica Specific Properties: Componenk

Yariability:
Causality:

] continuous

O <Unset> Einput ) output

— 1 EADS
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I/Tu“ ‘
\,—;“ ModelicaML Tutorial

Hint: Setting of the component properties
(Declaration, Causality, Variability, etc.)

rf_ﬁ Project Expl

S L
= B2 TwaoTanksExample
[=-E3 Design
ﬁ TanksConnectedpPI
B3 Library
=-E3 Components
ﬁ LiquidSource
ﬁ PIcontinuousController

Bl Model Explar 53

= ﬁ Tank.
=%, components (107

0 tSensor
O bActuator
O qIn Prs
O gqouk ::::"
R FlowGain SN
B miny A
EA  maxy \\\
[ area
[ height
G leveldfLiguid

Page 26

= Properties &3

E-'—J; MaodelicalL Yalidation @ Error Log El consale

O < <wariable>> <Property> flowGain : ModelicaReal

LML

ModelicaML

Modifications
Declarakion
Cond, Expression

Array subscripts

Prafile .-

- -

LML
MaodelicatL

Modifications

H Declaration

Cond, Expression
Array Subscripks
Profile
Advanced

20.03.2011

Mame:

Tvpe:

| “lowizain

<Primitive Type > ModelicaReal

+ Modelica Specific Properties: Component

Wariability; | pararmeter

Causality: () eUnset> Olinput () output
7FIu:uw Flag: () eUnset> (Oflow () stream

Scope! () eUnset= Olinner () outer

Final: Citrue (%) False

Replaceable: {itrue (%) False

=0.05




ModelicaML Tutorial

Create Class Components

=-E3
= AckSignal
=1, components (1)
[=-Edl ack
=L type (1)

MaodelicaReal

= E LiquidFlow
=¥, components (13
(=Bl [Flaww
= Ly type (1)

ModelicaReal

= E ReadSignal
=¥, components (13
=B wal
=L type 1)

ModelicaReal

Page 27

Q=1
=

i i
ofl o

9
-l

=-E3 lerary

= T_, u:u:umpu:unents (7
=8 cIn

=L bype (1)
E ReadSignal

E- 8 oot

= L kype (1)
AckSignal

0= «

= Ly type (1)
MadelicaReal

L, type (1)
ModelicaReal
errar

Ly type (1)
ModelicaReal
oubCkr

L. type (1)
MaodelicaReal
ref

L type (1)
ModelicaReal

= ﬁ Ll':IUII:I SOUFCe
=1, components (2
=B qOut
=Ly bype (1)
&
O flowieve
= Ly type (1)
ModelicaReal

IcankinuousContraller
=¥, components (13
T
=L typeil)
ModelicaReal

® => Set variability to “parameter”
0 => Set causality to “input”
B8 => Set declaration

=

e
=

rik.

mr’;

o
=

20.03.2011

components (100

LSensor

L type (1)

E Read3ignal
tactuator

L, type (1)

E AckSignal

gln

L type (1)

E LiquidFloms

gk

L, type (13

E LiquidFloww
Flonaizain

L, type 1) [EOOSNN
MaodelicaR.eal
mriny
L type (1)
'
maxy

L, type (1)

F*] ModelicaReal
area

L, bype (1)
height
L type (1)
ModelicaR.eal
levelDfLiquid
L type (1)
ModelicaReal
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Create Function Arguments

(SR ¥ (irnit!alue
=¥, Funckion Arguments (41
O & prin
=L typeil)
ModelicaReal
O & pmax
=L typeil)
ModelicaReal
i R
=L type (1)
ModelicaReal
® » plim
=L typeil)
ModelicaReal

0@ => Set causality to “input”

©® => Set causality to “output”
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ModelicaML Tutorial

Create Class Diagram

& Papyrus - modelicaml.example. twotankssystem/model. di - Eclipse

File Edit Diagram ‘Window Help

AL DRI

E- Model Explor 53 [ Project Expl = O ||#D *model.di 52

o AR BESs "

= B2 model
=-E3 Design

ﬁ TanksCanneckedPT

=-E3 Library

= ﬁ BaseController
t. components (7
=%, behavior (13
#@ Equations(Code)
@ limitvalue

=-E3

Liquidsc Import profile from registered profile

= ﬁ PIcontin
t eute
L, finhe
t. comy
t. behs
ﬁ Tank
EE Controlle
£ Interfaces
=-E3 Simulations
ﬁ TanksSwskel
Y profileapplication

Page 30

Impart package From File
Impart package From reqiskered library
Creake Query

Execute Query
Mewy Child
W Delete
J validation
Q& ModelicaML: Code Generation [ Simulation
" ModelicaML: Mew Element
P MaodelicaML: Mew Diagram

Mewy Diagram

5

Delete

bl T . .

= _ Class Diagram

20.03.2011
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AodelicaML Tutorial

General: Working with diagrams

Creating edges:
o Select the palette tool

eClick on the edge source element
and hold the mouse button

e Move the mouse to the target
element and release the mouse
button

Page 31

<3 *madel.di &3

emodels
BaseController

emodels 9

PIcontinuousController

20.03.2011
= O
.2 Palette [
[ & &
= Classes £
E3 Package
Q Class
8 @ Model
Enumeration
@ Zalculation Model
@ Requirernent
{7} Bssert
(Constraint)

[== Relations Ll

o & Extends Relatian

" Dependency

[== Annokation 4
= Annokation
= Comment

EADS



AodelicaML Tutorial 20.03.2011

General: Working with diagrams

Deletion of elements:
 Right click on a diagram element

emodelz
BaseZonkroller

 (preferred) Select the option “Delete Selected
Element” in order to delete it from the model. This is -
recommended in order to keep the model and the qﬂ,nddmm
diagram consistent

Mavigate L4
PIcnntilj:noDl File ’
. . . Edit L4
 Select the option "Hide Selected Element” in order to saEeblnletn i
remove the element from the diagram. The element £ e SelectedFement._ Delte
will still exist in the model and can be shown on the Pt .
diagram by drag&drop. B Cortrollr Inhd - Fomat b
= Properties £3 “J Filters y
A < <extend 7P View b
L ] Show Properties View
Modifications
Profile ic Ore
Appearance

[ TAwvaid obstructions
Advanced

Pago 2 EADS
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Configure Diagram Palette

Page 33

Papyrusl ML lassDiagram Standard Palette
v org.openmodelica, modelicaml, profile

o Palette
[}3 @) =)

Lawauk b
Use Large Icons

Cuskomize. ..
Setkings...

! Pinned

ﬁ}}
= B

[
@ right click here...

ian

r Maodel

@ Requirermnent

{7} Assert

(Constraint)

[-= Relations

4

v A~ Extends Relation

. Dependency

[-= Annotation

4

= Annokation

= Comment

20.03.2011
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Create Extends Relation

*Drag & drop BaseController and
PlcontinuousController onto diagram

*Use the palette tool “Extends Relation”

Page 34
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& Papyrus - modelicaml.example. twotankssystem/model. di - Eclipse

File Edit Diagram ‘Window Help

oo _ o £ r: e
fodn v W i - il — | B
B Model Explorer 52 [ Project Explarer = O |79 model.di 22
=
| d ~
- Ol =
5= | B B2 model
_ emodelz
=3 Design BaseContraller
@ TanksConnectedPl
=-E3 Library

= ﬁ BaseController
t. components (7
=¥, behavior {1}
i@ Equations(Code)
& lirithalue
=-E3 Components
@ Liquid3ource
= @ PlcantinuousConkroller
t extends (1)
L, finherited elements {&)
t. components (13
=¥, behawior (1)
i@ eq: caclulake
ﬁ Tank

&

/7~ N\

xkendgielation:

wraadet?

PIcontinuousController

Contraller Inheritance

EADS
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Hint: Element Appearance: Show stereotype name

& Papynus - modelicaml.example. twotankssystem/model. di - Eclipse
File Edit Diagram ‘Window Help

ok - Do

: | Tahama g B A 2 Fr — - 100%s LB rEn T s EER®Em &k
B Model D fl\jPro]ecq = B[P model di 52 =0
:l; EE Q% % Palette
= TwoTanksExample | m @® e
BaseController (= Classes o
P Package

E Class

[ Enumeration
EehiEalautationaliods!

[ Relations &0
v A Extends Relation

wkendsRelation:

«rnodeks
PleontinuousController

" Dependency

(= Annotation &
=) Annotation
= Commenkt
HE Contraller Inheritance 52 CompositeDiagrann | T,- sm! Tank States |
= Properties &2 [T'!l ModelicaML Vahdat\onw @ Error Lng] (= Canso\ew = ¥ =0
H <<model>> <Class> BaseController

>

urL Transparency EI

ModelicaML

5 Class Components T 5% -
B P - Stereotype Display: Text Alignement: Display Place: | Compartment

B |

) Appearance §Applied stereotypes:
=] ‘BaseControler’ component Bdvanced
B cInil) 2F model  (from ModelicaML: :ModelicaClassCaonstructs)
cOuk (1)
errar
K=z
oukCkr
ref

B T=10

Qualified Mame Depth:

Element icon: [

shadow : [

=

Page 35 EAD S
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20.03.2011

Hint: Element Appearance: Compartments

& Papyrus - modelicaml.example. twotankssystem/model. di - Eclipse

File Edit

Diagram ‘Window Help

|Tah0ma - |8

=
O

o=

Page 36

I
B Model 22 E"_‘,Projecq =0
DR AR

B2l TwaoTanksExample

<9 model.di &3

.
«models
BaseController

3 showiHide compartments

Choose the compartments to show

= O
B attributeCompartment
|:| E OperationCompartrenk
&[] B MestedclassifierCompartment

[ Select Al ] [ Deselect al ]

) add Mote

Mavigate

’ @ [. QK J[ Cancel ]

File

i Edit
¥ Delete Selected Element Chrl+Delete
£+ Hide Selected Element: Delete

«mode
Plcontinuous

Format
~J Format

< view

Chrl+F5

Controller Inherit
EE ] Show Praperties Yiew

E Properties 2 N Propetties

E < <model= = : Remove from Conbext Chrl+Al+Shift+Dovwn

4‘ amnarkmant | awank | Abamatic |

EADS
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\,ﬁ ModelicaML Tutorial

Hint: Editing Modelica Code

*Syntax highlighting and code completion is supported in code editors

*Hit Ctrl + Space for code completion when editing Modelica code

Page 38

= Properties 23

#@ < < equationsCode > <0Opaque Behavior> Equations(Code)1

kAL

Modelicarl
Equations

Profile

Advanced

@f MadelicaML Yalidation

@ error = ref - ol

[l wal

20.03.2011
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Create Behavior

= ﬁ BaseController | Properties &3 E-'—l- MaodelicatL Yalidakion
t. components (7
=¥, behavior {1}

& - < equationsCode> > < Opaque Bel
¥ EquationsiCode)

error = ref - cIn.val;
L Cout. ack = oukChr;|
Modelicarl
Equations
=53 Library = Properties &3 @.; MaodelicalL ¥ alidation
ﬁ BaseController

@ itV alue ﬁ' < < function:> <Function Behavior > lir

LML pLim ;= if p=pMax then pMax
else if p=pMin then pMin
ModelicarL else p;
Algorithm
Profile
Advanced

Page 39
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Create Behavior

=BT Caomponents
= ﬁ Liquid3ource
t. components (2)
=%, behavior (13
& eq: set ouktgoing Flow level

= @ PlcantinuausConkraller
Y. components (1)
=%, behavior {13
& eq: caclulate

Page 40

20.03.2011

E Properties &2 EFL ModelicaML Yalidation *:f| Error Log

i@ < < equationsCode>»> < 0Opaque Behavior> eq: set outgoing flow level

LML Lot Flow = if time = 150 then 3*flowlevel else fowLevel;

ModelicaML
Equations
Profile

Advanced

= Properties 3 EF\'.,.- ModelicatL Yalidation

@ < <equationsCode>> < Opaque Behavior> eq: caclulate

der(x) = error/T;

L aukChr = K¥*{errar + x);

ModelicaML

Equations

EADS
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Create Behavior

= Properties 3 [tz ModelicaML Yalidation

= Tark
t. components (103 # < < equationsCode > > <Opaque Behavior> eq: ballance equation
=¥, behavior (1) - LML der{levelOfLiquid) = (gIn.Flow - gout Flowfarea; [ Mass balance equation
@ eq: balance equation qiout. flowve = model. Design, Library limitYaluedminy, maxy, -FowEain®tactuator, act);
- Modelicarl
Equations tSensar wal = level OFLiquid;|
e~ Fil-

EADS
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Create State Machine

& Papyrus - modelicaml.example.twotankssystem/model. di - Eclipse

File Edit Diagram ‘Windomw Help

fo-de - B Pi- o - W B 7| A v | By ol -
- Model Explor £3 [75 Project Expl = B ~P *model.di 52
=
i3 d =
O ﬁ a lz = <='|=:>
5l B8 B2 model
. amodeks
=3 Design BaseController
ﬁ TanksZonnectedPl
=-E3 Library

= @ BaseController
t. components (7
=1, behavior (1)
@ Equations{Code)

@@ limityalue xtendsRelation:
=-E3 Components

il Liquidsaurce «modeks

PIcontinuousControler PleontinucusController

=

Impaort profile From registered profile

EEEE
e

Import package From file
EE Zon Import package from registered library a

3 Inkerfa Create Query
=B simulations Execute Query

Wl TanksS  ew child v
1 profileapplic 3¢ Delete

Delete
J walidation 4
QEL rodelicalML: Code Generation [ Simulation 4
) ModelicalL: Mew Element 4

Connection Diagram
Mews Diagram L4 & Machine Diagram

h Conditional Equations Diagram
h Conditional algarithm Diagrann

[a0]| Rename, ..

of Cut I
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Configure Diagram Palette

R AR R A TR SR ol =
=
B

F.Y L]
| 2 Palettke

[
! Tank States \| [% @ & . rlght CIle here ..

Layauk L4 i
Use Large Icons I
=001 - Cuskamize. ..
—_— Partially Filled _\| Settings...
PapyrusldMLSkakeMachineDiagram Standard Palette Histary
0.0l & v ord.openmadelica. modelicanl. prafile , Pinred
levElDfLiquid > height X él Chaice
el0fLiquid < height v @ EntryPoint
¢ (@ FinalState
== Edges ]
=2 Transition
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General: Working with diagrams

State Transitions:

sm: Tank States

o Select the palette tool

lewelOfLiquid = 0,01

. 3 Partially Filled

L <
/J levelOfLiquid < 0,01 l\

eClick on the transition source state
(click on label) and hold the mouse

IevlalOFLiquid = height

button 4 [}? F‘+a|ett_e b
Move the mouse to the target state @;des =
1 Reqion
(to its label) and release the mouse o
button @ Initial
@ ShallowHistary
v 3|} Fark

» {}l Choice
v i) EnkrvPoink
» (@ FinalSkake

[-=- Edges 40
=3, Transition

Page 4 EADS
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ial

Create State Machine

20.03.2011

& Papyrus - modelicaml.example. twotankssystem/model. di - Eclipse
Filez

0.0
t*m

=
o=

i g

Bib v o

Edit Diagram ‘Window Help

|.—[\j Project Expl
AR EE

B Madel Explor 52

= B2 model
=-E3 Design
ﬁ TanksConnectedPl
=-E3 Library
= ﬁ BaseController
t. components (7)
=, behavior (13
@@ Equations{Code)
@ limityalue
Components
ﬁ LiquidSource
ﬁ PIcontinuousController
Tank
t. components {10}
=, behavior (23
@ eq: balance equation
=-C* sm: Tank States
t region (1)
%3 sm: Tank States
EE Contraoller Inheritance
B3 Interfaces
=BT Simulations
ﬁ TanksSystem3imulation
t_ profileapplication (113

w-E-E- [ ®

B Class Components Tree &2
(&]E ®

=] Q 'Tank' components

B area

B Flowizain

E2 height

B levelOfLiquid

B maxy

=0

-

|

<P model.di 2

HERETEBRTesREBEEE®B @R

sm: Tank States

Empkty

levelOfLiquid = 0,01

Partially filled

levelOfLiquid < 0,01
levElOfLiquid = height

levelOfLiquid < height

Overflow

<

EE Controller Inheritance EE Controller Inheritance | Y sm: Tank States &2

] Properties 53

@f ModelicarL Validation

@ =Transition> levelOfLiquid > 0.01

LML
ModelicarL
Guard Code
Priarity
Prafile
Appearance

Advanced

=0
¢ Palette [»
= Nodes 40
(%) Region
&0 State
@ Initial

® ShallowHistary
+ 5[} Fark
3 él Choice
» @ EntryPoint
+ @ FinalState
= Edges 40
=% Transition

i’vn:uﬁ

levelofLiquid = 0,01

Page 45



Architecture Modeling

EADS
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Create Connection Diagram

*Create a ModelicaML Connection Diagram under the
TanksConnectedPI class

*Use components tool from the palette to create components

iInside the class on the diagram e b
-Define the types of components L
*Use Model Explorer to find the ports @Etpt
*Drag&Prop ports into respective components 7 Cannection
*Arrange the components - o

*Use the “Connection” tool from the palette for connecting
ports

Page 47 EADS
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Model System Architecture

& Papyrus - modelicaml.example.twotankssystem/model. di - Eclipse

20.03.2011

File Edit Diagram “Window Help

R N il -E

< | B model Explar 52
=

|.—[\:| Praject Expl

o=

= B2 madel
=-E3 Design
= ﬁ TanksConnectedPl
t. components (5)
1, commections (6)
Compositeliagranm
3 Library
F3 Components
B3 Interfaces
=-E3 simulations
ﬁ Tanks3ystemSimulation
Y profilespplication (113

Page 48

o- B QBB

-~ | &-ea- HhERTE=TasRERE®R &R
= O #% model.di 2
{é—> -~
amodelz
TanksConneckedPl
“Companentz
SOUPCE gln
#Companents
qCut tankl

tSensor  bActuatar

Lcompanents
kankz

controllerl

it

tZensor  EActuakol

conkrollerz

<
EE Controller Inheritance CompositeDiagram &3

=0
Lo Palette I
[; & &
= Components )

Component

o Pork
& Connection

=) Comment

£

I

EADS
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Create Connection Diagram

Page 49

& Papyrus - modelicaml.example.twotankssystem/model. di - Eclipse

File:

0o
&'n

Edit Diagram Window Help

‘}.pv‘f‘fvf: -

|Tah0ma

&
O

B Madel Explar 52

E\j Praoject Expl ] =0

I Y

o=

= B TwoTanksExample
=-F3 Design

(= |_)

2
[
=
[

-3 Lbrary
-3 Componen
#-E3 Interfaces
F-E3 Simulations
it

g

-~ tankl

& tankz
-~ controllerl
~I@ controllerz
#-t, connections (&)
CampositeDiagram

profileApplication {113

E@ TanksConnectedPT
E|T_, components (5
& source

bype (1)
@ LiquidSource
-

t. behavior (1)

ks

<9 model.di 53

=0
| S Palette
Haa
TanksConneckedPT
(= Components <

“COMmponesnts:

SOurCe E

controller

controller?

<l

_ Component

o Port

By contraller Inheritance CompositeDiagram 2 ]T,- sm: Tank States |

B Class Components Tree

b =08
BB @~

E Properties 12

@‘f ModelicatL Vahdat\on} @ Errar Log] = Console}

B < <component>> <Property> source : LiquidSource

= Q 'LiquidSource' companents

o qout(1)

B flawlevel = 0.02

urL Iame: | source |
ModelicaML
Madifications Type: |Q <<model>> «Class> LiquidSource

Cond. Expression

Array Subscripts

Prafile Final:
Appearance Replaceable:
Advanced

« Modelica Specﬁc Properties: Component

Obrue () False
Oitrue () False

i 0

20.03.2011
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Hint: Hide the name of all connectors

*Click on the compartment of the class
*Right-click -> “Select” -> “All Connectors”

*Right-click on one of the selected connectors -> “Filters” -> “Show/Hide connector
Labels” -> “No connector Labels”

T 52 Palette

TanksConnectedPI e ediedl K& &
== Components
. @ —omponent
tankl Mavigate » =
File: 4 i
i) Add Hate & Connection
Edit » Eadtuakor
I i Navigate » =) Cornrment
File: 3
inkrollerl -
Edit L4
U % Delete Selected Element  Chrl+Delete
Hide Selected Element Delete
o2 Arrange Al All shapes ]
Filters &l Connectars Format 4
- . - i &l Connector Labels Show/Hide Connector Labels 4
~J Formak ‘% No Connector Labels

LY
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ModelicaML Tutorial

Hint: Element Appearance: Hide the name of the
connection stereotype

Page 51

& Papyrus - modelicaml.example. twotankssystem/model. di - Eclipse

File:

Edit Diagram ‘Window Help

H@

fi= o |8 ARl Ak o ERIBLTEBBEREE o5
B Model 52 @Projecq = 07D *model.di &2 = O
= .
S a = o
= EABES «components o7 Palette [
=le C=) TwoTanksExampls source ,E@,{ @,
=-B3 Design = ; -
[ E TanksCannectedPl ; : ompanents
ACOMPonent:s |COMPONEnCs Companent
-0 Library kank bankz =] P
=3 Components o Paort
B@ LiquidSource qout gln qout .
H E|T_, camponents (2) &~ Connection
H- O gout
Comment
E|I§| FlowLevel tActuakor tSensar =
Ly type (1)
%, behavior (1)
ﬁ PIcontinuausCantroller
Tank «compaonent:
HE Controller Inheritance contraller1
#-B3 Interfaces
H-C0 simulations
bt profileapplication (11)
£
EE Controller Inheritance CompositeDiagram 3 ] 1. sm: Tank States |
=] Properties 53 [EL ModelicaML \u'alidationw @] Error Loﬂ =2 Consolew = ¥ =0
# < <connection> <Connector> Connection3
=0 — @ nNone O al (&) Semi-Circle () Square ~
= LML W
B Qass Components T E : Smoothness: OEelow O shove (O chamfered
|§| RO ModelicaML @hore O Mormal
i 1 Oless OMore [Creverse jump links
Appearance
Advanced -
Stereotype Display: Text Alignement: Display Place: _
applied stereotypes:
E]
&
u

20.03.2011



Component Modifications

EADS



ModelicaML Tutorial 20.03.2011

Define Component Modifications

& modification editor,

B Model Explar 52 [ Project Expl = 0
wARBes”
= B2 TwoTanksExample
=-E3 Design
= ﬁ TanksConnectedPI
=-*, components (5
[El =source
[E tankl
=
= trolle
E controllerz

9[ Ok, l l Cancel
E Properties &2 E-'—J, MaodelicatL Yalidation | &

O < <component>> <Property> controllerl : PIcontinuousController

LML miodification:

ModelicatL ref = 0,25 [ﬂ] [iy w
I Modifications I 9
Cond. Expression

Array Subscripks

page s EADS
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Define Component Modifications

=l Properties &2 E-'—J, ModelicarL validation @ Error Log
O < <component>> <Property> source : LiquidSource

LML rnadification:

MaodelicakL FlowLevel = 0,02

Modifications
,- -sConneckedPI = Properties &2 E-'-L ModelicatL Y alidation '@7 Error Log
= ) = << component>> <Property> tankl : Tank
source

kankl

= modification:
#-[E kankz
= cnntrN‘ Modelicarl area =1
=

controllerz Modifications

El Properties &2 @; ModelicatL Yalidation Ef| Error Log

O < <component>> <Property> tank2 : Tank
madification:

Modelicarl area= 1.3

Modifications

El Properties &2 E-'—J, ModelicalL Walidation @ Error Log

O < <component>> <Property> controller2? : PIcontinuousController
rnodification:

ModelicatL ref = 0.4

Modifications
Page 54
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ModelicaML Tutorial

Validate Model

Page

& ModelicaMl Modeling - modelicaml.example.twotankssystem_v02/model. di - Eclipse Platform

File Edit Diagram Search ‘Window Help

B Madel Explarer 52 [[\:, Project Explorer

BOl’RE

= B2 TwoTanksExampls
[ Requirements
[ _walueBindings
=-E3 Design
@ TanksConnectedPl
ﬁ TanksConneckedPID
£ Library
=-F3 Components
ﬁ LiquidSource
ﬁ PlcontinuousCantraller
E PIDcontinuousController
E Tank
ReadSignal tSensor
AckSignal tackuator
LiquidFlow gIn
LiquidFlaw qQut

(1] - ]

parameter Real miny =0
parameter Real maxy = 10
parameter Feal area = 1
parameter Real height = 2
Real volume = area * height
Real levelOfLiguid

eq: balance equation

smi Tank States

< < |
Vgt g@iecnonm

parameter Real flowsain = 0,05

=0

<=-=4>v

¥ Class Components Tree &7 <:=='g> 5 ® ¥ =0

= E 'TanksSystemSimulation 1' components

= designModel (5}

_inputs (2

req_vaolume_of _a_tank_1 (4)
req_wolume_of _a_tank_2 (4}
req_input_flow_limits_1 (5)
req_level_control_bounds_1 (%)
req_max_level_of_liquid_in_tank_1 (4}
req_max_level_of_liquid_in_tank_2 (4]
_reqTestResults (<)

R e e AR e R |

=
=
=
=
=
=
=
=

B

20.03.2011

= Biv oo - L4~ % . T 1L »
P *model.di 23 =08
M0 s Palette I
TanksConneckedPl h =
SOUrce
= Components 40
Component
o Port
& Connectian
= Comment
v
< £
T.g Test case: Change. .. EE Requirement texk ... Eé Reguirement kext ... EE Requirement text ... Eé Tank System Simul. ., Tank Syskem Archi,., B2 | ™%
1 Properties @, ModelicaML Yalidation &3 & conscle @ Error Log B_\, Problems | S5 Progress =0
1 items
Description Location

i; ModelicaML validation: Mo errors were detected for 'TwoTanksExample', TwoTanksExample
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Simulate Model

Page 58

& ModelicaML Modeling - modelicaml.example.twotankssystem_v02/model.di - Eclipse Platform
File Edit Diagram Search ‘Window Help

F- Model Explarer 52 [ Project Explarer = 07D *madel.di 52

= B3 TwaTanksExample

£ Requirements

F3 _WalueBindings

=3 Design
ﬁ TanksConneckedPT
ﬁ TanksConneckedPIl
£ Library
3 Components
£ Interfaces

=-E3 Simulations

ﬁ TanksSwstemSimuls

ﬁ TanksSystemsimuls
ﬁ SimulationModel1
EE Simulation reuse
t_ profileapplication (147

O T = =

TanksConnectedPl

SOUrce

Impart profile From reqistered profile
Import package from File
Import package from registered library
Creake Query
Execute Query
' ModelicatL: Mew Elernent
'3 ModelicalL: Mew Diagram
i ModelicaML: Helper
ModelicatL: Yalidation and Code Generation

[17] MadelicaML: Simulation

EL Ll ol

qout | kankl
aln gtk

2
2
2
2
2

LSensor

tadtuakor

controller 1

cln ooy

(00 Sirmulate with CMSim Center
| 2
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Simulate Model

& New Modelica Model Wizard

Create a new Simulation Project

This Wizard supparts the user to create a new simulation
project using an existing Modelica model

Path ko Project Faolder:

| 5i\_PROJECTS|2005_Phbitonisieripse 3 6.1 || Browse.. |
*Project name: | TanksConnectedPl_20110316150721 |
Wersion: | 1.0 |
Author: | |
Company: | |
Camment: no comment ek

Please select the simulation tyvpe.
II @ Mon-Interactive Simulation

® [ <o

& Simulation Session Configuration

Prepare a non-interactive simulation session: Simulation Setup

Please setup the simulation. Please fill all information marked wikh (%)

Canfiguration Daka

20.03.2011

*Configuration Mame: | Config_201103161505

*ersion: | 1.0

Author: |

Compary: |

Comment:

Sirulation Setup

Page 59

Start: 0.0 |
Stop: | 400 |
*Cutput Inkerval: | 1| | |s vl
*Tolerance: | 0.0001 |
*Solver: | dasslz v |
|Sg¢ Restore Default
Skart Sirmulation I
@ < Barck Mext = [ Finish Cancel ]
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Simulate Model

Modelica Non-Interactive Simulation - modelicaml.example.twotankssystem_v02/model. di - Eclipse Platform

Diagram ‘Window  Help
§|Tah0ma V|9 V|BI|A'&'-I'_"|ﬁ'E'DE' I'"I;"(| N
g = "y = "
5 Mor-Interactive Simulation Control 52 O || 3 Man-Interactive Simulation Yisualisation &2 |
=l |E| TwoTanksExample,Design, TanksiZonnectedPT H .
% L contlor Simulation Results
[#-[] controllerz
D|E| karkl 0,55
[ der{levelfLiquid) 0,90
level OfLiquid
- dln 0,83
B[] goue
B[] sm__Tank_States 0,80
ED thctuatar 0,75
&[] tsensor
] walumne 0,70
B [E] tankz
[ derfleveldfLiguid) 0,65
levvel OfLiquid
0,60
: [ dIn
B[] gt F_-.EI,SS
-] sm__Tank_States -
IED tactuator 3 b,s0
IED tSensar To4s
O] welume
[ source 0,40
-] time:
0,35
0,30
0,25
0,20
0,15
0,10
0,05
0,00
u] 23 50 73 10 125 130 175 200 225 230 275 300 323 330 373 400
Time (s)
Find: | | [search ] —tank2. evelofliguid — tankl. levelofLiguid
i
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godelicaML Tutorial

Launch Modelica Code Generation

& ModelicaML Modeling - modelicaml.example. twotankssystem_v02/model. di - Eclipse Platform

File Edit Diagram Search ‘window Help
B —+ T
- Maodel Explorer 53 r[\jProject Explarer =0
05 A%

= B2 TwoTanksExample
=-E3 Requirements
@ Wolume of a tank

|

g input Real inputFlowLevelTankl

& constant Real min =0

[ constant Real max = 0.0

[ output Boolean violated = inputFlowlevelTankl < minar in
EE output Boolean evaluated = true

t. Comments {13
E—é Requirement kext and measurable properties

@ Max level of liquid in kank

@ Settling time and bounds after a change of input Flow
O _ValueBindings
=-E3 Design

ﬁ TanksConnectedPI

ﬁ TanksConnectedP I

O Library

=-F3 Compaonents
@ LiguidSource
E PIcontinuousController
ﬁ PIDcontinuausController
ﬁ Tank. B
EE Controller Inheritance
B3 Interfaces “

EB@° -0

=3RRI ]

& Class Components Tree &7

= Q 'Tanks3ystemSimulation 1' components
designModel (5)

_inputs (2]

req_volume_of _a_tank_1 (4}
req_valume_of_a_tank_2 (<)
req_input_flow_limits_1 (=)
req_level_contral_bounds_1 ()
req_max_level_of _liquid_in_tank_1 (4}
req_max_level_of_liquid_in_tank_2 (4)
_reqTestResults (4]

S s o B
I0D0Do@moo@

@ 1 items selected

. . . . mE . &
B~ of- o“z@@fﬁf’u'z S S b
<D *model.di &2

sm: Tank States

lewelOfLiquid = 0.01
Enpty Partially Filled |
levelfLiquid < 0.01
levElOfLiquid = height
lewelOfLiquid < height
Overflow
<

B

£

20.03.2011

& - 2=
|
L& Palette [
I @
= Modes E5+)
(%) Region
&0 State

@ Initial
® ShallowHistory

+ +[} Fark

» §1 Choice

v+ (2 EntryPoint

+ (@ Finalstate

= Edges E5+)
=% Transition

EE Requirement text ... EE Requirement text ... EE Tank Svstem Simul, .. E'é Controller Inheri... T’B sm: Tank States 57 | ™%

= Properties 23

EF], ModelicatL validation | ] Console Cﬂ Error Log B_\ Problems | S Progress

H < <requirement:> <Class> Input flow limits

uML
ModelicarL
Prafile

Advanced

=__.’

—+l, - =
¥ =

&

A~
Tame: | Input: Flow limiks | 3
Is Abstract: Otrue () False Is Ackive: Oitrue (®) false
Is Leaf: Oitrue (8)False
visibility [ public 7
Use Case: —
‘ bt

S



rodelicaML Tutorial

Generated Modelica Code

& ModelicaMl. Modeling - modelicaml.example. twotankssystem_v02/model.di - Eclipse Platform

20.03.2011

File Edit Diagram Search ‘Window Help

%‘. IModel Explordr r[\j Project Explorer 3

= rnodelical

B 7 A —

'Sb' of -

EI|§| o 7 T O79 *model.di 22

== code-gen
= TwoTanksExample
= _valueBindings
== Design
== Components
LiquidSource . mo
package.ma
PlcontinuousController, mo
PIDcontinuousController.mo
Tank.mo
(= Interfaces
(= Library
package.mo
TanksConneckedPLmo
TanksConnectedPID. mo
== Requirements
Input_flows _limits,mo
Ma_level_of_liquid_in_tank.mo
package.mo

‘olume_of _a_tank. mo
(= Simulations

. package,ma

Sektling_time_and_bounds_after_a_change _of _jinput_Flow

st Tank States

levelOFLiquid = 0.01

Empky

lewelOfLiquid < 0.01

leveldfLiquid < height

<

(= validation-gen
g doce.i ]
= model. notation
@ model, uml

< |

= =

B Class Components Tree 232 = @
= Q 'TanksSystemSimulation 1' commponents

= designMadel (51

=] _inputs (2}

= req_volurne_of _a_tank_1 (4}

= req_volume_of _a_tank_2 (4}

= req_input_flow_limits_1 (=)

= req_level_control_bounds_1 (%)

:¢ # 3 model,di - modelicaml, example bwokankssyskem_v0z

= Properties 52

IE; ModelicaML validation | B Console @ Error Log [3_\ Problems | S5 Progress

Eé Requirement kext ... EE Requirement text ... Eé Tank System Sirul. .. Eé Controller Inheri... T,ﬂ sm: Tank States 52 | %

model.di - modelicaml.example.twotankssystem_v02

Resource PGS
= Info

> ]

= detived

8 editable

2 last modified

— lirked
lacation
nams
path

y size

v <

(=M1 o o7 1
aa ™ B o B
=0
- [»
= MNodes 4
(%) Region
&0 State
Partially filled ® Initial
@ ShallowHistory
v ->|]3 Fork
levelOfLiquid = height R él Choice
v @ EntryPoint
+ @ Finalstate
Overflow
= Edges 4
_ D% TranSitiDn
v
|
= ~ =08
Walue 2
false
true
16, Marz 2011 15:07:01
false
D\ PROJECTS20068_PhDitools\eclipse_3_6_modelingiruntime-Mew_config..
model, di
Imodelicaml. example bwotankssystemn_v02 fmodel, di
2,971 bytes L
A/
Ed

Page 63
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ModelicaML Tutorial

Formalize a Textual Requirements (Example 1)

1.
2.

20.03.2011

|ldentify and formalize measurable properties addressed in the requirement statement
Define when requirement is evaluated (pre-condition) and violated

“requirements
Mazx level of liquid in kank

leellnTank :
tarkHeight / Measurable properties

violated
evaluated

|
The level of liguid in tank shall never
exceed 80% of the tank height.

[

Page 65

evel of liquid in tank,

Edl input Real levellnTank

[Eal input Real bankHeight

Eal oukput Boolean violaked = levellnTank. = (tankHeight + tankHeight * 0.5
[ outpuk Boolean evaluakted = true

EADS



ModelicaML Tutorial

Formalize a Textual Requirements (Example 2)

requirernents
Setting time and bounds after a change of input Ao

inputLevelZhanged
inputFlo

timeut measurable
levellnTank .
refLevel propertles
i

ma

gvaluated

violated

After each change of the tank input flow, the
contraller shall, within 20 zec., ensure that the level
of ligquid intank iz equal to the reference level with a

tolerance of +i- 0.15 m.

20.03.2011

= @ Settling time and bounds after a change of input Flow

+-[Eg Boolean inputlevelChanged = abs{inputFlow - delay(inpukFlow, 0,133 = 0.0001
+1-[Egl  inpuk Real inpukFlow - — . ~
4B constant Feal time ok = 20 inlation Maritor
+-[Eg input Real levelInTank
+-[Ed inpuk Real reflevel
+-Ed Real min =reflevel - 0.15
+-Ed Real max = reflevel +0.15 [r Waiting For input: Flow to change \| ( Yiolated
H-BF oukput Boolean evaluated input Flow changed | fentry OpagqueBehavior Set evaluated and wiolated
) lexit OpagueBehavior Unset violated
#-[Eg output Boolean violated L
=I-(* Yiolation Manitar PN input Flow changed
(" Ohserving )
level is ouk of bounds after timeout
AFTER(HimeOut) - Evaluated w input Flow changed
Waiting fentry OpaqueBehavior Set
evaluated. ..
.
. A
Page 66
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ModelicaML Tutorial

Instantiate Design Model

File Edit Diagram <~ #Diagram  Search ‘Window Help

- [H [/ & i |Tahoma a H Ty 5

E‘ Hiii iiiiiii ﬁ i %F‘mject Explnrer} = EP “ ¥ model.di
FAlRBEs "

= B2 TwaoTanksExample
L-T-.IEI Feguirements
L-T-.IEI _WalueBindings
EIEI Dresign
=-F3 simulations
: EI@ TanksSystemSimulation 1
: EIIEJ designiodel{. .}
E||_) tvpe (1)
\ ﬁ TanksConnectedPl

Page 67

Set kankl contraller ref = 0,25 and Flaw level ko 0,01

20.03.2011

Jentry OpagueBehavior Entry code

J/ AFTER(10)

Sek Flow level = 0,04

b

lentry OpaqueBehavior Enkry u:u:u:leJ

-

Set Flow level = 0,06

lentry OpaqueBehaviar Entry code

-

Sek Flow level to 0,02

b

lentry OpaqueBehavior Enkry u:u:u:leJ

AFTER(40)

|(_ Set kankl controller ref=10.6 _\]
Jentry OpagueBehavior Enkry l:l:udEJ

AFTER{SO)

Set tankl controller ref = 0,25 _\]
Jentry OpagueBehavior Enkry u:u:u:leJ

AFTER(S0)

AFTER{SO)

A
A



ModelicaML Tutorial 20.03.2011

Instantiate Requirements

=BT Simulations

-]

@ Tarks Import profile from registered profile

EE Sirulal Impart package From File
t profileappl Import package From registered library

controller1

Creake Query

cln ooy

Execute Query

' ModelicaML: Mew Element r
@ ModelicaML: Mew Diagram »
55 ModelicatL: Helper » Ef Instantiate Requirements
Q& MadelicaML: Validation and Code Generation » 'sF‘i Ipdate Requirements Test Oracle Elements
—

=-E3 Simulations

D TwoTanksExample::Reqguirements:: Max level of liquid in tank
* This requirements should be instantisted 2 times

The level of liquid in tank shall never exceed 80% of the tank height.

req_max_level_of_liquid_in_tank_z(. .3
_reqTestResults(, )

Test case: Change input Flow level and
t. nested classes (2)
s EE Tank Syskemn Simulation: Test Scenario 1

Page 68 EAQS

#® ModelicaML Helper: Instantiate Requirements = ﬁ Tan kermSirulation 1 (with PT controllers
Select requirements to be instantiated in: TanksSystemSimulation 1 =l designiodel(..)
E _inputs
Sort by: or search for: | |[ Search ] [ req_wolume_of_a_tank_1(..)
003: Input flow limits 9| L & I’E—'q_.‘\.-'l:I|I.II'I'IE_I:IF_-?I_FaI'Ik_2|:--:l
[/ req_input_Flow_limits_10,.]
006: Max level of liquid in tank S |” F req_level control_bounds_10..)
id: D06 R req_max_level_of_liquid_in_tank_1(..)
Tl
=
=




ModelicaML Tutorial 20.03.2011

Bind Design Inputs and Requirement Properties

3

B Class Components Tree &0 |<~}=='{:>| @ A\~ O

= Q Inputs of 'TanksSystemSimulation 1 {with PI controllers) components
4 =& designModel ()

Stimuli and parameters =@ source (1)

. . B flowlevel = inputs.dm_source_FlowLewvel Show all components
fOF deS|gn mOdeI ) =& contrallerl (1) ® Show only input variables
controllerl. ref = _inputs.dm_controllerl _ref ) Bal ref = _inpuks.dm_controllerl _ref Shaw anky output variables
source. flowlevel = _inputs.dm_source_flowlevel =& contraller (13 =how StateMachines

Al ref =0.4

\_ & _inputs i)
=& req_volume_of _a_tank_1 (1)

[ tankyolume = designModel, tankl, volume
=& req_wvolume_of _a_tank_2 (1)

A tankyolume = designModel, tankz  volume
[=-[&l req_input_Flaw_limiks_1 (1)

Exa m ple fO r req u | reme nt B inputFlowlevelTankl = designModel. tankl.gn. Flow
p ro pe rt| eS b | n d | n g : =& req_level_control_bounds_1 (3]

EE inputFlow = designModel. tankl . gIn. [Flow
inputFlow = designiodel.tankl . qIn.|Flow

& levellnTank = designModel, tankl levelfLi ..
levellnTank = designModel. tankl . levelOFLiquid &8 reflevel = designModel. controller ref
reflevel = designfodel.contraller1 . ref =& req_max_level_of_liquid_in_tank_1 (2}
& levelInTank = designModel, tankl levelFL .
A tankHeight = designModel kankl  height
=& req_max_level_of_liquid_in_tank_z (2}
B levellnTank = designiModel. tankz . lewveldFL . ..
EE tankHeight = designModel tankz, height

page s EADS



ModelicaML Tutorial 20.03.2011

Finding Properties that are Linked Through Mediators

Instantiates a class and enables the finding of different
/ properties that are linked through mediators

t5 Class Components Tree &5 |<,1='=f>| =)

= E 'TanksSyskemSimulation 1 Design Alkernatives (PI contraller)’ companents
= dri(5)
=& req_wolume_of_a_g
EE tankiolume
[ requiredsglum
A winlated = ab |
A evaluated =t
=& req_wolume_of_a
A tankialurme
G requiredvolum
B violated = abs
B evaluated =t
[El req_input_Flow_i
[El req_level_contral |
[El req_max_level_af
[El req_max_level_af

& _reqTestResults (4 * Mote, this modification will be stored in 'TanksSyskemSimulatidn 1 (with PT
@& _inputs (2) controllers),.req_wolume_of_a_tank_1"

& List of Linked Instances (2)

2 wariables were Found in this class, You can seleck
click. "O' in order to rekurn their dot-path ko the ed

* req_volume_of_a_tank_1.tankiolurme | *

3 tankiolume =,
V| dmn.tankz  volume

& Edit Component Modification

| Find variables (33) | | Find Linked variables (7 | | oK |

Pago 1 EADS
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ModelicaML Tutorial 20.03.2011

Bind Design Inputs and Requirement Properties

Challenge:

— When requirements and design are instantiated in a test model for simulations their
properties need to be bound (i.e. requirement properties must access the right values
from the design model)

— Is it possible to support or even automate the binding?

Questions:

s How to find the right design model properties, that requirements properties shall be bound
to, without having a deep knowledge of the design model?

=& req_level_control_bounds_1 (3}
+-Eal inputFlow = designfdodel kankl . gIn.Flow
+-[6g levellnTank = designModel tankl lewvelOfL ...
4Bl reflevel = designiodel.contrallerl . ref

— A requirement may be needed to be instantiated multiple times (e.g. for each tank or
@ controller). How to know how many times a requirement should be instantiated and what
- are the respective bindings to the design model properties?

=& req_max_level_of_liquid_in_tank_1 (2}
+-Ed levellnTank = designModel.tankl level QL ...
+-Ed tankHeight = designiModel, tankl, height
=I-[@ req_max_level_of_liquid_in_tank_2 (7]
+-[Ed levellnTank = designModel tankz, levelOFL ..

Page 72 +-Eg tankHeight = designModel. tankz . height EL\DS



ModelicaML Tutorial

20.03.2011

Bind Design Inputs and Requirement Properties

Mediators Concept:

ValueMediator is a ModelicaML concept that allows to define a n:n relation between
properties of different classes.

— This is done at the class property level and enables the finding of linked properties when
they are instantiated in the same class hierarchy (e.g. in the same simulation model)

— ValueMediator are only used at modeling level and do not affect the code generation
ValueProvider provides the value

ValueClient obtains the value

When formalizing requirements the requirements analyst creates and reuses
ValueMediators and defines which requirement property should obtain the value from
which ValueMediator

When creating the design model (based on requirements) the designer defines which
design model properties provide value for which ValueMediator

Page 73 EA\DS



ModelicaML Tutorial 20.03.2011

Using Mediators

Req Ul reme nt -l Properties 23 E'.'\I./ ModelicatL Yalidation
= @ Settling time and bounds after a change of input Flow B < -<wariable, valueClient> > <Property: levellnTank : ModelicaReal
B Boolean inputlevelChanged = abs{inputFlow - delay(inputFlow, 0.1, applied stereotypes: E
B input Feal inputFlow LML
Ba consktant Real timedut = 20 ModelicaML Wariable  {from ModelicalL: :ModelicaCompositeConstrucks)
B input Real levelInTank Fodfications = YalueClient  (From ModelicaMLTesting: :ValueBinding)
B input Real refLevel Declaration obtainsyalueFrom: WalueMediator [0, .%] = [levelOFLiquidInT ankMediator]
@ Real min = rEFLEVEl -0.15 Caond, Expressign
E Real max = reflevel +0.15 Array Subscripts
EA output Boolean evaluated Profile
EE output Boolean violated

Design Artifact Mediator
=l Tan Ly level2fLiquidInTankMediakor

O Readsignal tSensar

O ActSignal bActuator

O LiquidFlow gIn

O LigquidFlow gout

parameter Real FlowiEain = 0,05
parameter Real mind' =0
parameter Real maxy = 10
parameter Real area = 1
parameter Real height = 2

Real wolume = area * height = MalueProvider  (from ModelicaMLTesting: :MalueBinding)

Real levelfLiquid =8 rrovidesValueFor: YalueMediator [0..%] = [levelOfLiquidInTankMediator]
eq: balance eguation

sm: Tank States

Page 74 EAQS
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ModelicaML Tutorial 20.03.2011

Why Using Mediators?

Support for the access of design properties values:

» ValueMediator is an interfaces the design model provides in order to enable
support for requirements properties to the right design properties.

Handling of properties that are mentioned in multiple requirements

» ValueMediator concept is beneficial because it enables a consistent list of same
properties that are reused in multiple requirements

Design Model Alternatives Handling

* ValueMediator concept is used to encapsulate the design model alternatives.
Multiple design alternatives provide the value for the same ValueMediator.

page 1 EADS
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20.03.2011

Traceability Between Requirements and Design

Properties

Requirements

= @ Yolurne of a kank
input Feal tankiolume
conskant Real requiredvolume = 2

LRI IR

oukput Boolean evaluated = true
Inpuk Flow limiks

input Real inpukFlowleyvelTankl
conskant Real min=10

consktant Real max = 0.08

i
e = e

IR IR SIR IR

oukput Boolean evaluated = true

= @ Maz level of liguid in tank
[Ed  input Real levellnTank
Ed input Real tankHeight

output Boolean violated = abs(kankvolume - requiredvolume) =0

obtainsValueFrom

output Boolean violated = inputFlowlevelTankl <-min or inputFlowlevelTankl = max

Eg output Boolean violated = levellnTank = (tankHeight + 0.3 * tankHeight)

Eg output Boolean evaluated = true

= @ Settling time and bounds after a chanage of inpuk Flow

inpuk Real inpukFlow
conskant Real tmeCut = 20
input Feal levellnTank

input Feal refLevel

Real min = reflevel - 0,15
Real max = refLevel +0.15
oubput Boolean evaluated
output Boolean violaked
Winlation Monitor

R
Ve EdEadaa

Boolean inputLevelChanged = abs(inputFlow - delay(inputFlow, 0.1, 0,20 =0

Mediators

=l \alueMediatorsContainer

e kankiolumeMediator

e levelOFLiquidInTankMedic

v kankHeightMediato
Ly bankInputFlowMediakor
L referecenLevelMediato

Page 76

providesValueFor

Design Artifacts

= @ Tank

ReadSignal tSensor

=

Qe gEgEdlonnoem

ActSignal bActuator

LiquidFlow gln

LiquidFlow qout

parameter Real FlowEain = 0,05
parameter Real mink' =0
parameter Real maxy = 10

I R R

parameter Real area = 1
parameter Real height = 2
Real wolume = area * height
Real levelQfLiguid

eq: balance equation

sm: Tank Stakes

m

IcantinuousCantraller

D Ell|g.g
=)

extends BaseiZontroller
= ﬁ BazeControfier

O ReadSignal cIn
O AckSignal oouk
parameter Real i =2

- E

R AR IR RN

parameter Real T =10
inpuk Real ref = 0,25
Real error

Real oukiZkr

eq: Egquations{Code)

RN R

A Realx
i@ eq: caclulake

EADS
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Finding the properties that are linked through mediators

Instantiates a class and enables the finding of different
properties that are linked through mediators

N

t5 Class Components Tree &5 |<,1='=f>| =)

= E 'TanksSyskemSimul B Edit binding 'PI conkraller)’ components
& dm (5) " £ List of Linked Instances (2)
/7 Delete binding
= req_wolume/of ©
B tankvolumg 1 Show details t Modification 2 variables were Found in this class, You can select
& requiredvolum click 'Ok in order to return their dot-path to the ed
B violated = abs &3 req_vnlu.lzé_nf_a_tank_l.tank‘u‘nlume | -

EA evaluated =t @ tarkyolume =,
=& req_wolume_of_a /m
A tankialurme

G requiredvolum
B violated = abs
B evaluated =t
[El req_input_Flow_i
[El req_level_contral |
[El req_max_level_af
[El req_max_level_af

& _reqTestResults (4 * Mote, this modification will be stored in 'TanksSyskemSimulatidn 1 (with PT
@& _inputs (2) controllers),.req_wolume_of_a_tank_1"

| Find variables (33) | | Find Linked variables (7 | | oK |
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